
Working Model 2D 
The world’s most popular 2D computer aided engineering tool 

 
• Powerful physics-based 2D kinematic 

and dynamic motion simulation and 
analysis 

• Provides accurate solutions to complex 
engineering motion simulation problems 

• Save time and money by avoiding 
expensive prototyping and product 
failures 

www.workingmodel.com 

Use automatic collision de-
tection and friction to accu-
rately model real-life me-
chanical systems 

Track the motion of an 
object under specific 

simulation parameters 

Record and display simula-
tion data in realtime 



www.workingmodel.com 

www.workingmodel.com 

SUPPORTED 2D FORMATS 

• DXF file format 
 
BODY PROPERTIES &  
FEATURES 

• Body types: circle, box, poly-
gon and smooth (b-Spline 
edges) 

• Mass, density, geometry, 
center of mass, moment of 
inertia, velocity and angular 
velocity, electrostatic charge 
and more 

• Track the motion path of a 
body 

• Automatic collision detection 
and response 

• Automatically applied static 
and kinetic friction 

 
CONSTRAINTS 

• Pin, rigid, slot, keyed slot 
and curved slot joints 

• Rods, ropes, pulleys and 
gears 

• Linear and rotational spring/
damper 

 
MOTION DRIVERS 

• Motor 
• Acturator 
• Force 
• Torque 
 
Constraints and drivers can be 
defined by numeric or equation 
input in the formula editor, or with 
tabular data. 
 
UNITS SYSTEMS &  
FORMULAS 

• SI, English, CGS and 
user-defined 

MEASURABLE PARAMETERS 

• Position 
• Velocity 
• Acceleration 
• Momentum 
• Angular momentum 
• Constraint force and torque 
• Gravity, electrostatic and air 

force 
• Kinetic energy, gravitational 

potential energy and power 
 
Record and display simulation 
data in real-time with graphical 
and digital meters. 
 
SIMULATION CONTROL 

• Run, stop, reset, single 
step, or pause the simula-
tion at any time. 

• Control the accuracy of 
your simulation by modify-
ing integration and anima-
tion steps and configura-
tion tolerances. 

• Superimpose multiple 
simulations. 

 
INTERACTIVE CONTROLS 

• Connection to Excel and 
MatLab 

• Complete “Visual Basic” 
style scripting language 
with built-in debugger 

• Menu and script buttons 
• “Player” mode for content 

creation 
 
VISUALIZATION 

• Track the motion path of a 
body or its center of mass 

• Attach graphics to bodies 
• Images on bodies rotate 
• Display system center of 

mass 
• Multiple, moving reference 

frames 

SCRIPTS 

• Optimize 
• Create constraint 
• Document model 
• Zoom to extents 
• Measure distance be-

tween points 
• Flip polygon 
• Multiple file run 
• Pin friction 
• Slot friction 
• Slot damper 
• Flexbeam 
• Shear and bending mo-

ment 
 
OUTPUT 

• AVI video files for play-
back 

• Meter data from simula-
tions to tabular data file 

 
PRINTING 

• Print an image of your 
simulation or meter data 

WORKING MODEL 2D  
SYSTEM REQUIREMENTS 
Window System 
• Microsoft Windows 95/98/

ME/2000/XP/Vista/ 
Windows 7 

• 1 GB RAM Minimum 
• 60 MB disc space 
• CD-ROM drive 

Design Simulation Technologies 
43311 Joy Road, #237 
Canton, MI 48187 
USA 
www.design-simulation.com 
sales@design-simulation.com 
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Welcome to Working Model 
 
Working Model is the result of a 15-year collaborative effort between professional engineers and software specialists.  We are 
committed to providing you easy-to-use, engineering software that makes you more productive, and saves time and money on 
hardware prototyping, testing, and virtual product development.  
 
To begin, install Working Model and go through each step of the demonstration described below.  
 
 

 
 
 
Installing Working Model 
 
1. Insert the Working Model CD into the CD-Rom drive and 
follow the installation instructions 
2. When prompted for a serial number, enter “DEMO” or enter 
your licensed serial number 
 

 
 

3. When the “Choose Folder” window appears, click [OK]. 
4. For a step-by-step introductory tutorial, turn to the next page. 
 

 

http://www.workingmodel.com 
Last updated by Paul Mitiguy and Michael Woo
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Starting Working Model 
1. Ensure that Working Model is installed on your computer.  
2. From the Windows  Menu, click on Programs, then Working Model, and 
then Working Model. This opens a simulation. 

 
1 Creating a Falling Block 
1. The first simulation is Newton’s first experiment, dropping a block.  
2. To draw a rectangle, click on the Rectangle tool, then click in the workspace and 
draw a long thin rectangular block.  
3. To run the simulation and see the block fall due to gravity, click . 
4. Click  to reset the simulation.  
 

 

 
2 Adding a Velocity Vector 
1. To add a velocity vector, click on the rectangle. 
2. From the Define menu, click on Vectors and then Velocity. 
3. Click  and observe that the vector changes magnitude as the block falls. 
4. Click .  
 
Optional: To show the velocity vector’s x and/or y component, click on the Define 
menu, select Vector Display, and check the X and/or Y box. 
 

3 Making a Pendulum 
1. To make a pendulum, click on the Pin joint tool and then click on the upper left-
hand corner of the rectangle.  
2. Click  and observe that the vector changes magnitude and direction as the 
pendulum moves. Click .  
 

 
 
Optional: Each click on  at the bottom of the screen advances one frame.  
 

4 Graphing the Pendulum’s Motion 
1. To graph the pendulum’s motion, click on the rectangle. Under the Measure 
menu, select Position, then select Rotation Graph.  
2. To collect data, click . Note: Data can be displayed as a graph, bar chart, 
or number, and can be changed while running the simulation by clicking the  on 
the top left-hand corner of the graph. Click . 
3. The graph shows the pendulum’s amplitude and frequency. To make the graph 
larger, click on the graph and drag its lower right-hand corner to the right. 
 

 
 
 

5 Changing Gravity 
1. To change gravity, click on the World menu, select Gravity, type the value 20 
m/sec2 in the input box, and click [OK]. 
2. Click  and observe that, in agreement with theoretical and experimental 
predictions, the pendulum has a higher natural frequency. Click . 
 

Note: Working Model was designed to be easy-to-use. For example, in this 
exercise, the only time you need to touch the keyboard is to enter the value 20. 

 

 
 
6 Adding Air Resistance 
1. Under the World menu, select Air Resistance, click on Low Speed, and accept 
the default air resistance value of 0.3 kg/(m*s) by clicking [OK]. 
2. Click  and observe the exponentially decaying oscillations. Click . 
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7 Adding a Spring 
1. To add a spring, click on the Spring tool. Click on the upper right-hand corner of 
the block and stretch the spring up and to the right. 
2. Click  and observe the pendulum's higher natural frequency and new 
equilibrium position. Click . 
 

 

 
8 Controlling the Spring Constant 
1. To control the spring constant, click on the spring. Under the Define menu, select 
New Control, then select Spring Constant.  
2. The slider that controls the spring will appear in the left-hand side of the 
workspace. To move the slider's location closer to the spring, click on its title and 
drag it next to the spring.  
3. To see the effect of varying the spring constant, click  and observe that the 
pendulum angle is a function of the spring-constant (move the slider up and down 
while the simulation is running). Click . 
 

 
 
Optional: The properties of any object can be modified by double-clicking on any object (e.g., the 
rectangle, pin point, graph, spring, spring-constant control). 
The appearance or geometry of an object can be modified by clicking on the object, selecting the 
Window menu and selecting Appearance or Geometry. 

9 Collisions with a Smooth Polygon 
1. To create a smooth polygon, click on the Curved Polygon tool, click in the 
workspace in a few locations. Double-click to close the polygon.  

(If your rectangle is high on the screen, click  to zoom to extents.) 
2. Click  to start the simulation and observe that the curved polygon bounces 
and rolls on top of the rectangle. Automatic collision and contact is a very useful 
feature in Working Model (even the elastic and frictional properties of objects may 
be varied). Click .  
 

Note: Collision sound/motion sound can be added to a simulation. To add a 
collision sound, click on the curved polygon, select the Measure menu, and 
choose Hear the Collision. (Windows only; computer speakers required) 

 

 
  
10 Smart Editor 
1. Working Model's Smart Editor allows the user to change an object's position and 
orientation while keeping constraints intact.  
2. To change the orientation of the rectangle, click on the rectangle and drag the 
mouse to rotate the rectangle counterclockwise so that it is nearly vertical as shown 

below. (If necessary, click  to view to extents.) 
 

11 Creating a Cam-Follower Mechanism 
1. To add a motor to the curved polygon, click on the Motor tool, and then click on 
the curved polygon.  
2. Click  and observe that the rectangle's motion is determined by the shape 
of the curved polygon and the motor's speed. Click . 
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12 Creating a Flexible Beam 
1. To convert the rectangle into a flexible beam (Flexbeam), click on the rectangle. 
2. Under the Script menu, select Flexbeam. 
3. In the “Flexible Body Information” dialog box, accept the default values and click 
[OK]. Click [OK] in the “No Flexbeam Undo” dialog Box. 
4. Click  to start the simulation and observe that the formerly rigid rectangle is 
now acting as a Flexbeam. Change the values of the “EI” and ‘Damping - Bending” 
sliders to change the Flexbeam’s stiffness and damping. Click . 
 

 
 

13 Animation Step and Integrator Error  
1. To change accuracy, select the World menu and then Accuracy…  
2. Select an Integrator Error small enough to meet your accuracy requirements.  
3. Select an Animation Step that produces smooth visual results. 
 

14 Importing DXF Files 
1. Open a new simulation by selecting the File menu and clicking on New.  
2. To import a DXF file, select the File menu and click on Import. 
3. In the Import window, navigate to the directory where Working Model is installed, 
for example, C:\Program Files\WorkingModel and then select the sub-directory 
WMIntroduction. 
4. Select the file WMDXFDemo.dxf and click [Import]. This imports the DXF objects 
(a crane, wrecking ball, a Working Model logo, and an abandoned building). 
5. Click  and watch all the objects fall due to gravity. Click . 
 

15 Simulating a Building Demolition 
1. To anchor the base of the building, click on the Rigid Joint tool, then click on the 
base of the building. 
2. To anchor the crane, click on the Rigid Joint tool, then click on the crane. 
3. To fix the Working Model logo to the crane, click on the Rigid Joint tool, then click 
on the Working Model logo. 
4. To attach the wrecking ball to the crane with a rope, click on the Rope tool, then 
single-click on the ball, and then single-click on the crane to create a rope. 
5. Click  and observe that Working Model detects the shape of the imported 
DXF objects and automatically calculates how they collide. Click . 
  

 
 

16 Adding Colors to DXF Objects 
1. Objects that are imported from a DXF file are treated the same as objects 
created within Working Model. You can change their appearance, measure their 
velocity, acceleration, etc.  
2. To add color to the crane, click on the crane. 
3. Under the Window menu, click on Appearance. 
4. In the Appearance window, note that the fill pattern is currently set as “no.” Click 
on the drop-down menu and change it to another pattern. 
5. Click on the fill color drop-down menu and change the fill color to blue. 
6. Close the Appearance window. 
7. To change the color of the other objects, repeat steps 2 to 6.  
8. Click  to start the simulation. Click . 
 

17 Running Demo Files 
1. Under the Script menu, click on “Run All Demo Files”. 
2. Sit back and enjoy a series of demos on a variety of engineering topics. 
 

 
 

18 Creating a Movie  
1. You can create a movie from any Working Model simulation.  
2. To see an example, select  menu, then Programs, then WorkingModel, 
then WMIntroduction, and then double-click on WorkingModelMoneyBowl.avi. 
 

 
 

http://www.workingmodel.com 
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Working Model® 2D (Windows Only)
Node Lock Dongle Network

US$ US$
Single User 2,995 4,995 1 1
2-User 5,495 6,995 1 2
3-User 7,495 8,495 1 2
4-User 9,495 9,995 1 2
5-User 11,495 11,495 1 2
10-User 18,495 18,495 1 3
20-User 33,495 33,495 1 4
30-User 48,495 48,495 1 5
Custom User Call Call Call Call
Training Call Call Call Call
A - A limited number of free additional CDs and/or manuals are available with original purchase 
Maintenance renewals are 20% of the Retail Price and are provided by Design Simulation Technologies or a certified reseller.

1
2

3
4

be added to the order or a UPS, DHL, or Fedex account must be provided.

Working Model 2D Professional
The Americas Price List – February 1, 2009

http://www.workingmodel.com

Description # of CDsA # of ManualsA

The first year of technical support and maintenance is included with initial purchase.

Sales tax is extra
8

Orders to US and Canada: American Express, Visa, MasterCard, Discover, checks, purchase orders accepted. 
International orders: American Express, Visa, MasterCard and bank wire transfers accepted.  For orders less than $1,000 shipping charges will 

4
5
6
7

8 Prices and terms are subject to change without notice.

A copy of the customer’s purchase order and/or purchasing information must accompany all orders.
Technical support is provided by Design Simulation Technologies or a certified reseller for the first year of ownership and is extended yearly 
upon maintenance renewal.

When possible, orders are shipped within 48 hours.
All sales are final.  If you are tentative about a purchase, ask for a demonstration copy.


